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Using the Sample Files—a Preflight Pro tutorial

Extensis Preflight Pro gives you enormous control over what job
elements can be inspected and flagged, problem thresholds, and
how information is reported. Preflight Pro even assists you in
examining and correcting problems, gathers job elements together
when the job is ready to be transferred to another facility or out-
put, and makes the task of getting a job ready for output faster
and easier than ever before.

The following tutorial, combined with the Sample Files on the
Extensis Preflight Pro CD, gives you a comprehensive view of
what’s possible using Preflight Pro. We will introduce you to the
overall process of preflighting, familiarize you with the different
job elements that can be checked and flagged, show you how to
generate a problem report, show you how to use Preflight Pro to
examine and correct problems, then show you how to collect all
the job elements together in preparation for sending to the output
facility.

Note: For more detailed information on each of the features cov-
ered in this tutorial, and for information about Preflight Pro fea-
tures not covered here, refer to the associated reference material
in chapters 3 through 7.

Starting the Job

The first step in preflighting is to create a job file. The job file
contains all the info rm ation pertinent to the job, i n cluding (but not
limited to): documents included in the job; Job Ti cket info rm at i o n
and Output Instructions; info rm ation gat h e red about potential
p ro blem elements in each document such as picture s , fo n t s , a n d
c o l o rs; plus info rm ation from the last rep o rt ge n e rated prior to
closing the job jacke t , i n cluding pro blems found and their seve ri t y. 

The first, and primary, screen in Preflight Pro’s electronic job file
is the Job Jacket. The Job Jacket provides access to nearly all the
features and functions available in Preflight Pro.

2—Preflight Pro Start to Finish
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To create a new job (open a Job Jacket):

1. Launch Extensis Preflight Pro.

Double-click the Preflight Pro icon. With no job selected,
Preflight Pro automatically opens a new Job Jacket with the
Files tab selected.

2. Name and save your new job.

Select “Save” from the File menu (or press zS). Type in a
name for your new job, then save it to an appropriate location.
The name in the Job Jacket title bar will be changed to reflect
your new job name. In this tutorial we’ll be using the filename
“Sample Files Job.”

Note: Once the file is named and saved, Preflight Pro saves
changes automatically as you work.

Add documents

After you’ve created a new Job Jacket, you’ll want to add docu-
ments for Preflight Pro to inspect. 

To add documents to the job:

1. Locate and open the Sample Files folder on the Extensis
Preflight Pro CD.

2. Select the files Sample One and Sample Two, then drag
and drop them into the open Job Jacket Files tab window.

Notice that the status of the files is “Not Inspected.”
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Document Inspections

Before Preflight Pro can report on problems or conditions that
might prevent the document f rom outputting pro p e rly, document
data must be gathered and processed. This is done by performing
an Inspection. Inspecting a document causes Preflight Pro to gath-
er information from it that can be analyzed for potential problems. 

Ve ry detailed info rm ation about each document is ava i l able after
the inspection—including document para m e t e rs , output para m e t e rs ,
and info rm ation about the job elements (fo n t s , p i c t u re s , and colors )
found in the document. Included in the info rm ation gat h e red are the
documents and pages wh e re each element was fo u n d, and other
i n fo rm ation specific to the document or individual job element. 

You can use the va rious tabs inside the Job Ja cket window to ex a m-
ine the info rm ation that was gat h e red during the inspection, and lat e r
ge n e rate a pro blem rep o rt to alert you to potential pro blems. 

Examine the tools ava i l a ble in the Button Bar:

1. Pass the mouse over each button in the Pre flight Pro
Button Bar, and notice that the button function ap p e a rs in
the Help box in the bottom-left corner of the window. 

As you go through this tutorial, notice that the column headers
in the files list—as well as the page and status icons associat-
ed with each document in the list—also are described in the
Help box. Look for similar Help boxes in other Preflight Pro
windows.

Note: When page icons appear in the document list, such as
after Inspection, passing the mouse over the page icon dis-
plays the page number in the Help box. Also note that columns
in the document list can be resized by dragging left or right,
and can be reordered by dragging them above or below anoth-
er document in the list.

For detailed descriptions on the various tabs, buttons, and
icons, refer to chapter 4, “The Job Jacket” and chapter 3,
“Creating a Job Ticket” later in this manual.



Inspect job documents:

In order to gather data about a document, Preflight Pro must open
and examine it in QuarkXPress.

1. Select both documents, Sample One and Sample Two.

Documents in the Job Ja cket can be inspected indiv i d u a l ly, a l l
at the same time, or in any combinat i o n .

Note: Use the SHIFT key to select multiple documents con-
tiguously; use the z key to select multiple documents non-
contiguously; press zA to select all documents at once.

1a. Optional: If you have more than one copy (or version) of
QuarkXPress, specify which copy to use.

If you have only one copy of QuarkXPress, Preflight Pro will
locate it automatically when you inspect the document.
However, if you have multiple copies (such as on mounted dri-
ves on a shared network) or multiple versions (such as for
compatibility with clients) you should indicate which copy of
QuarkXPress you wish to use.

To do so, select “Preferences: General” from the Edit menu.
Click “Specify,” then locate the copy of QuarkXPress you
wish to use. Note that this selection becomes the default. Yo u
will need to rep e at this process when you wish to direct Pre fl i g h t
P ro to use a diffe rent copy of the Quark X P ress progra m .

Note: If you have QuarkXPress launched when you select a
document for inspection with Preflight Pro, Preflight Pro will
use the open application when inspecting your document. 

2. Inspect the selected documents by clicking the “Inspect
Selected Documents” button.

Preflight Pro will launch QuarkXPress, open the specified
documents, and gather all of the information needed for pre-
flighting. Preflight Pro keeps you posted on it’s progress with
a progress bar. When the inspection is complete, Preflight Pro
will close the documents.

N o t e : If a document was open prior to inspection by Pre fl i g h t
P ro , P re flight Pro will leave it open after inspection.

N o t e : You can instruct Pre flight Pro to leave documents open
when the inspection is complete, if you wish. Refer to ch apter 4,
“ The Job Ja cke t : Setting Pre fe re n c e s .”

When the inspection is complete, the pre l i m i n a ry analysis will
be indicated by the Status and Page icons in the documents list.
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Examining Inspection Results

Get a quick over-view of inspection results:

1. Notice the Status and Page icons that now appear in the
document list.

When the inspection is complete, Preflight Pro summarizes
the results in the document list. Problem severity is deter-
mined by settings in the Profile assigned to the document
(Profiles are described on  page 17).

STATUS icon indicates overall document status. It is based
on the highest severity problem found anywhere
in the document.

WHITE page icon indicates that no problems were found.
RED page icon indicates that one or more problems of

any severity were found on that page.
SLASHED page icon indicates that the page is to be exclud -

ed from the Report (see chapter 4 for details).

2. Change the status of displayed documents and pages by
deselecting the “caution” checkbox.

Notice that the Page icons in the list change immediately.

The “Show only” checkboxes in this window allow you to
quickly determine the overall severity of the document and
each document page. By limiting the status to show just the
problems indicated as “error,” several pages changed from red
to white. The “white” icon pages still have problems, we just
don’t want to consider them right now. The Status icon shows,
accurately, that there is at least one page in each document
with a problem of the highest severity (of type “Error”). 
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2. Next, click through the Pictures, Fonts, and Colors tabs in
the Job Jacket to see the types of information gathered
during the inspection. 

As you’re looking through these three job element tabs, dou-
ble-click on a picture, font, or color to open a detailed infor-
mation window about that particular job element. In the detail
window you will be able to see exactly what information was
gathered about the element. 

Note: For a detailed description of job elements and informa-
tion gathered during the inspection, refer to chapter 4, “The
Job Jacket” and chapter 5, “Working with Profiles.”

Notice that, although you now have access to an enormous
amount of very detailed information about the elements that
make up the job, you don’t yet have a quick and easy way to
identify problems in the job that might prevent it from out-
putting correctly. The next step in the process, “Creating
Profiles,” is important in assuring that Preflight Pro provides
you with exactly the information you need to determine
whether or not your job will output properly.
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Profiles

Profiles are an important part of the versatility of Extensis
Preflight Pro. Using profiles, you define which problem condi-
tions are of concern to you, and how critical each problem is.
Inside the Profile you can also set problem thresholds or toler-
ances as appropriate. All of the problems that can be found and
flagged by Preflight Pro are listed in the Profile tabs.

You can assign diffe rent pro files for diffe rent documents in the
j o b, and even specify Pro files for particular pages within a docu-
ment. You can specify Pro files for certain types of output
d ev i c e s , then share those pro files between clients and serv i c e
bu reaus to ensure that all jobs meet the re q u i rements of the out-
put dev i c e. And you can specify a default Profile that will auto-
matically be assigned to all new documents added to the job.

Note: Profiles are examined by Preflight Pro whenever document
data is analyzed. Data is analyzed when a Report is generated,
Output Instructions are changed, and when Profiles are created or
changed, unless the option “Only analyze when building report”
is selected in Preferences: General.

G e n e rating a Rep o rt or assigning a Pro file is wh at actually start s
the pro bl e m - finding process. The info rm ation in the Pro file is
ch e cked to determine wh at threshold constitutes a pro bl e m , a n d
h ow the item should be fl agged when a pro blem is fo u n d. Pre fl i g h t
P ro considers each item in the Pro file and the settings in the Output
I n s t ructions and determ i n e s , for eve ry document and page indicat e d
as included in the Rep o rt , whether or not a pro blem ex i s t s .

When a problem is found, one of three condition flags will be set
for it: Error, Caution, or Ignore. Which of the three flags will be
set is determined by you when you configure each item in the
Profile. You might think of the problem condition flags as just dif-
ferent severity levels for problems, with “error” indicating a prob-
lem that would definitely keep the job from outputting correctly,
“caution” indicating problems that might keep the job from out-
putting, and “ignore” as problems that don’t affect the output, or
issues that, in your environment, don’t constitute a problem at all
(in other words, issues you don’t care about). If no problem is
found when a profile item is tested, no problem flag is assigned
and the item will not appear on the problem report.

Note: You can assume whatever meaning you wish for the Error,
Caution, and Ignore flags. Also note that all problems are flagged
and available for display in the Report window; problems indicat-
ed as “ignore” are not ignored by Preflight Pro, they are simply



18

tagged with the Ignore flag. Using the “Show only” checkboxes
you can choose not to display problems flagged as “ignore.” For
detailed information on problem conditions, problem condition
flags, and other profile information, refer to chapter 5, “Working
with Profiles,” and chapter 6, “Reports.”

We will provide more information about profiles as this tutorial
progresses.

Add a Profile and assign it to a document:

Since Profiles determine what is considered a problem, and how
severe each problem will be for the particular document type and
output device, you will probably use a number of Profiles, and
you may want to share Profiles with service providers and other
Preflight Pro users. 

1. Locate and open the Sample Files folder on the Extensis
Preflight Pro CD.

2. Select the “Sample Files Profile” and drag it into the
Preflight Pro Profiles folder in the Preflight Pro applica-
tion folder —or— drag it into the same folder where you
are storing your Sample Files Job file.

Preflight Pro looks in both locations for available Profiles.

N o t e : If the re q u i red Pro file cannot be found in either of these
fo l d e rs , the ap p l i c at i o n ’s Default Pro file will be assigned.

3. R e t u rn to the Job Ja cket Files tab window. Select the
document “Sample Two ,” and assign the “Sample Fi l e s
P ro fi l e ” to it. Do the same for Sample One.

In the Profiles column for the document Sample Two (on the
document list in the Job Jacket Files tab) click and hold the
mouse to enable the Profiles pop-up menu. This pop-up menu
lists all of the available Profiles, including the new Profile you
just placed there. Release the mouse over the profile item
“Sample Files Profile” to select it.

Next, assign the “Sample Files Profile” to Sample One.

Examine the document list and ve rify that the new Pro file has
been assigned to both documents.

N o t e : When you assign a new Pro file to a document, P re fl i g h t
P ro automat i c a l ly analy zes the document info rm ation gat h e re d
d u ring the inspection against the pro blem settings in the new
P ro fi l e, then updates the page icons to re flect any ch a n ge s .

•
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Problem Reports

In the section “Examining Inspection Results” you saw how the
document list in the Files tab window of the Job Jacket allows
you to see—using the Status and Page icons—whether a page or
document is problem-free or if at least one problem was found.

The problem Report gives you problem information in much
greater detail. And the Report window gives you access to the
Preflight Pro Pilot, where you can navigate through the problem
list to examine and/or correct problems right inside the document.

When you generate a Report, Preflight Pro checks the information
in the Profile to determine what threshold constitutes a problem,
and how the item should be flagged when a problem is found.
Preflight Pro then determines, for each item in the Profile and for
every document page that was inspected, whether or not a prob-
lem exists.

When a problem is found, one of three condition flags is set for it:
Error, Caution, or Ignore. Which of the three flags is set is deter-
mined by you when you configure each item in the Profile. If no
problem is found with a particular item, nothing is added to the
report concerning that item.

Problem results can be viewed on-screen in the Report window,
and the report can be printed. Using functions in the Report win-
dow, you can limit the information you view to only the informa-
tion you are interested in at the time. For example, you can indi-
cate which documents, and which pages within a document, you
wish to have the problems shown. You can limit the rep o rt to show
o n ly pro blems fl agged as “ e rro r,” o n ly pro blems fl agged as “ c a u-
t i o n ” or “ i g n o re,” or you can include in the rep o rt any combinat i o n
of fl agged conditions. You might want to print a detailed listing of
all pro blems fo u n d, then limit your on-screen view to only the
p ro blems you want to wo rk on correcting at a certain time.



Generate and view a report:

1. In the Job Ja cket Files tab window, select both documents
“Sample One” and “Sample Two ,” then cl i ck the Rep o rt
button on the button bar, or press zR .

The report window appears. The left side of the window is the
Report On list, which displays the list of documents being
reported on. Using checkmarks you can indicate which
pages—for each selected document—to include in the report.
A red checkmark at the document level indicates that not all
pages of that document have been selected for reporting.

Note: All documents which have been inspected will be listed
in the Report On list (un-inspected documents are not shown
since no information has been gathered for them—therefore
no problem report can be generated). While an inspected doc-
ument will appear in the list, page numbers will only be dis-
played for those documents that have been selected to be
reported on in the current Report.

The right side of the window shows
the Consolidated Report. It displays
the problems found on the pages
selected in the “Report On” list.
Notice that the listed problems are
organized by category  or section—
the same sections as given in the
Profile configuration dialog. Only
Profile sections where problems were
found are listed.

Recall that the job element tabs (Pictures, Fonts, Colors) in the
Job Jacket window show all the information gathered about
job elements when the Inspection was done, whereas the
Report window offers a combined or “consolidated” report of
all the problems that were found when the problem Report
was generated. Remember that problem severity (Error,
Caution, Ignore), indicated by the icon to the left of the listed
problem, is based on the problem conditions and flags as they
were set in the currently selected Profile for this document.

2. Notice that the Report window shows icons for error-
flagged problems and caution-flagged problems, and that
the “caution” checkbox is marked.

Notice the “Show only” checkbox at the top of the window.
Recall that earlier, in the Job Jacket Files tab window, we de-
selected the caution box—yet in the Report window the
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checkbox is selected. This indicates that the two “Show only”
selection areas are independent of one another: each affects
only the information on the screen on which the box appears.

3. Deselect the Caution checkbox in the Report window.

Notice that the Report window now shows only those prob-
lems flagged as “error.”

You can use the error, caution, and ignore checkboxes alone or
in combination to create the level of problem detail that fits
your needs. And you can include and exclude documents and
individual pages from the current report using the checkmarks
in the Report On area of the window.

N o t e : C h a n ges to the “ S h ow only ” ch e ck b oxes and the page - ex cl u-
sion ch e ck m a rks are re flected immediat e ly in the rep o rt .

4. Examine the Profile sections and problem items in the
Report window. Use the scroll bars to see the entire list. 

Notice the categories of problems listed (blue type), and the
types of problems listed. The problem categories and individ-
ual problem types shown in the Report mirror exactly the
problem sections and individual problems in the Profile.

Note: If a problem is not covered in the Profile, it will not be
reported on here—or anywhere in Preflight Pro!

5. Select a problem, then look at the More Info area at the
bottom of the Report window to get detailed information
about the selected problem and possible solutions.
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Optional: Print a Consolidated Report:

1. Select “Print” from the File menu (or press zP) to open
the print dialog. Click “Print.”

This prints the same information as shown on the current
Consolidated Report.

Correcting Reported Problems

After you’ve generated a Report to show you what problems
exist in your documents, you are ready to begin correcting them.
Preflight Pro makes the task of navigating through the problem
list quick and easy with a special Pilot palette.

The Pilot is a power-packed floating palette that stays active
inside QuarkXPress so you can move about inside your document,
checking and correcting problems as you go, and only returning
to Preflight Pro as necessary to reinspect documents or generate a
new report.

Correct a General profile section problem:

1. Click the “Open Pilot” button in the Report window.

When you click “Open Pilot,” QuarkXPress is launched and
the Preflight Pro Pilot palette appears. 

If a problem was selected in the Report window, the Pilot
palette will display this problem when the Pilot is launched. If
not problem was selected, the Pilot will open to the first prob-
lem on the list. Since the “General” section is the first tab in
the Profile, all General section problems are listed first.

2. Become familiar with the Pilot palette.

The Pilot palette indicates the currently selected Profile
Section as well as the total number of Sections reporting prob-
lems. Underneath this information on the palette is a numeri-
cal accounting of the problems (Item) in the indicated Section.
Notice that there are seven problem Items being reported.

Arrows next to both the Section and Item information allow
you to navigate the entire problem list without returning to
Preflight Pro. The bottom area of the palette displays the doc-
ument, the Item (problem) name, and the description and pos-
sible solutions information from the More Info area of the
Report window.
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3. Using the arrows on the Pilot palette, locate the problem
“Section: General (1 of 5), Item: 2 of 2; Output set to be
reduced or enlarged.”

This is a problem sometimes encountered when oversize pages
are printed to a smaller page output device, such as a laser
printer, for proofing.

4. Click the “Show” button on the Pilot palette.

Preflight Pro will open the document that contains the prob-
lem (in this case, Sample One), move to the appropriate page,
and select the appropriate job element or dialog box in the
document. 

Note: This action is similar to the picture update function
“Show me” in QuarkXPress.

5. In the document Page Setup dialog, change 80% to 100%.

This allows the document to print on the final output device at
the correct size, and completes the first problem correction.

Note: If you were not going to be correcting more problems,
you would want to Save the document before continuing. Since
we will be correcting a few more problems, there is no need to
Save the QuarkXPress document at this time.

6. Step to the next problem by clicking the right-hand arrow
beside the Pilot palette Item information.

The next problem will be displayed on the Pilot palette.
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Correct a Font section problem:

7. Ve rify that the pro blem displayed on the Pilot palette is
S e c t i o n : Font (2 of 5), I t e m : 1 of 1; Font styled as “ o u t l i n e.”

Text in a Type 1 font which is styled from the Style menu in
QuarkXPress can cause problems when the output device
attempts to locate the printer font—a font that doesn’t exist.

8. Click “Show.”

Since this problem item is contained in the document “Sample
Two,” Preflight Pro will open that document and move to the
problem area.

9. Remove the Style menu selection “outline” from the out-
lined text.

10. Step to the next problem by clicking the right-hand arrow
beside the Pilot palette Item information.

Correct a Picture Box section problem:

11. Verify that the problem displayed on the Pilot palette is
Section: Picture Box (3 of 5), Item: 1 of 1; Picture set to
suppress on output.

Sometimes a picture will be causing a problem or taking a
long time to image on the proofing device, and thus has been
set not to print. When the document is ready to be imaged on
the final output device, this setting must be turned off.

12. Click “Show.”

Since this problem item is contained in the document “Sample
One,” Preflight Pro switches quickly to that document and
moves to the problem area.



25

13. Select the offending picture and open the Picture Box
Specifications dialog (zM in QuarkXPress).

14. Deselect the Suppress Picture Printout checkbox.

This corrects the Picture Box problem.

15. Step past the next two problems by clicking the right-hand
arrow beside the Pilot palette Item information.

These two problems concern the Picture File Section (4 of 5);
we will attend to these problems later, in the Profile itself.

Correct a Color section problem:

16. Verify that the problem displayed on the Pilot palette is
Section: Color (4 of 5), Item: 1 of 1; Color “registration”
used.

Sometimes a designer will accidentally select the color
“Registration” from the the Color palette in QuarkXPress
instead of the more appropriate color selection “Black.” Since
the color “Registration” is used for items (like registration
marks) that print on all plates, selecting it indiscriminately can
cause problems in the output.

17. Click “Show.”

This problem item is again contained in the document
“Sample One,” so Preflight Pro moves quickly to the problem
area of the document.
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18. Open the Color palette and change the color applied to the
item from Registration to Black.

19. This completes the problem corrections to be made inside
the Sample documents.

All but 3 of the original 7 problems have been corrected. The
final three problems will highlight other functions in Preflight
Pro, so we will be leaving the Pilot and QuarkXPress. 

Save changes and Return to Preflight Pro:

20. S ave the ch a n ges to both documents Sample One  — and —
Sample Two by selecting “Save” from the QuarkXPress
File menu, or pressing zS. Do not quit QuarkXPress or
close the Sample documents.

21. Click the “Preflight Pro” button on the Pilot palette.

The Pilot palette will close and you will be returned to the
Report window.

22. Note that the changes are not yet reflected in the Report
window.

Don’t be surprised that your corrections have not yet been
reflected in the Report window—Preflight Pro must reinspect
the documents before it will be aware of exactly what has
changed.

23. Click the “Job Jacket” button in the Report window.

You will be returned to the Files tab in the Job Jacket window
(assuming this is the tab that was selected when the Report
was generated.)
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Reinspect the documents and verify that some prob-
lems have been corrected:

24. Examine the updated Job Jacket Files tab window.

The Status icon change to “Unknown” and the posting of
“Modified” in the page count column indicates that Preflight
Pro is aware of changes in the document. An inspection is
required to gather the changed document information.

24. Select both documents Sample One and Sample Two.

25. Click the Inspect button.

If QuarkXPress and the sample documents have not been
closed, the inspection should go very quickly.

26. When the inspection is complete, examine the Status and
Page icons in the document list.

From the reinspection, Preflight Pro has determined that the
corrections to Sample One: Page 4 and Sample Two: Page 2
have eliminated all problems of severity Error on those pages,
and thus changed the icons from red to white (a white icon
indicates no other problems of the severity indicated by the
“Show only” checkboxes were found on that page). 

However, each document still has at least one problem of the
severity Error, as indicated by the Error Status icon and one
red page icon displayed for each document.
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Change the Picture File section profile setting:

One of the problems noted in the Pilot palette which we did not
correct in the sample documents involved an incorrect Picture
File. The problem item was stated as: Incorrect picture format
(PICT). This problem affected both our documents.

We have consulted with the document designer and determined
that the picture format PICT is an acceptable picture format for
these two documents, so the problem is not really a problem at
all, as far as these two documents are concerned. But the Profile
for this document indicates that this picture format is a problem,
and unless we change the picture format, the document Report
and status icons will continue to show this as an error.

What to do? Since we work with many documents where PICT
files are appropriate and acceptable, it will be important to have a
setting in the Profile that allows for this picture format.

We determine that the appropriate course of action is to either cre-
ate a new Profile allowing the PICT format, or to change the cur-
rent Profile and use it for other documents where the pictures in
the PICT file format will not be a problem.

27. From the Profile menu, select “Configure Profiles.”

Note: You must be in the Job Jacket window (not the Report
window) to access this menu option.

The Configure Profiles dialog box appears.

28. In the Configure Profiles dialog box, select the Profile
“Sample Files Profile,” then click Edit.

Clicking “Edit” opens the Profiles dialog for the selected
Profile. To create a new Profile instead of changing this one,
we could have selected “Duplicate” or “New” instead.

The Profiles dialog always opens to the first, or General sec-
tion tab.
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29. Click the “Picture File” Profile tab.

30. Deselect the “Incorrect Formats are:” checkbox for PICT.

31. Click “Save.”

The Configure Profiles dialog will appear when the Profile
change has been saved.

32. Click “Done.”

This completes the Configure Profiles operation and activates
the Job Jacket. 

33. Examine the updated document list in  the Job Jacket Files
tab window.

The white page icons indicate that the problems associated
with job elements on pages in the document have been cor-
rected. However, one “Error” icon remains: the Status icon.
This icon indicates that the remaining problem affects the
whole document; it is not specific to a job element on a page.

Note: Because the change we made to the Profile affected only
the reporting options and not the document, Preflight Pro
could update the document list without reinspecting the docu-
ment. 

34. Click the Report button to generate a new report and open
the Report window.

We’ll need to view the report to see what the last remaining
problem is.
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34. Note the last remaining problem in the Report window:
G e n e ra l : Page dimensions do not mat ch trim size :
Sample Two .

35. Open the Document Setup dialog inside document Sample
Two and verify that it is set to 5 x 7, the correct trim size
for this document.

The trim size inside the document is correct, yet an error
displays. This indicates that we should check the document
Output Instructions in Preflight Pro, to make sure that the cor-
rect problem-check parameter for this document was set prior
to preflighting it.

35. Return to Preflight Pro by selecting “Preflight Pro” from
the Utilities menu in QuarkXPress.

36. Return to the Job Jacket Files tab window by clicking the
Job Jacket button in the Report window.

Change the Output Instructions settings:

37. In the document list, select Sample Two.

38. Click the “Output Instructions” button in the Button Bar.

The Output Instructions dialog box will be presented.
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39. Change the “Trim Size” setting in the Output Instructions
dialog from 8.5 x 11 to 5 x 7.

39. Click OK to save the change and return to the Job Jacket
File tab window.

40. Verify that all the corrections have been made.

The Status icon for both documents indicates that all the prob-
lems flagged as Error have been corrected. The icons further
indicate that there are potential problems with the documents,
but these problems will not keep the job outputting properly.

40. Experiment!

You could select both documents and generate a new Report
to verify from the Report window that all Errors have been
corrected. Or use the “Show only” checkboxes in the Job
Jacket Files tab window and Report windows to list the prob-
lems indicated as Caution, see how the Report is affected, and
use the Pilot to locate and correct the problems flagged as
Caution. Or you could exclude some pages from the report
using the Include/Exclude pages command in the Job Jacket
and/or the Report On area of the Report window, and see how
this affects the report.

Refer to the next sections for a additional options and features
to experiment with.
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Filling out the Job Ticket

The Job Ticket is the place, inside the Job Jacket, where all the
information about a job that is not associated with problem condi-
tions is kept. Job Ticket information is not required, but when
used, it is usually hand-entered by a human being. It includes
such important information as job contacts, media delivered with
the job, delivery instructions, billing, and other information. 

You can specify a default Job Ticket that has typical job informa-
tion in it, and then make the appropriate changes when a new job
is created.

Enter Job Ticket information:

1. From the Files tab window in the Job Jacket, click the
“Edit Job Ticket” button, or press zT.

This opens the Job Ticket window. Notice the five tabs indi-
cating the different types of information that can be entered:
Contact, Order Info, Delivery, Media, and Instructions.

C l i ck through the tabs to fa m i l i a ri ze yo u rself with the info rm a-
tion that can be entere d. On the Media tab, note that you can
specify both the input media (how the job was re c e ive d, s u ch
as on SyQuest or Jaz cart ri d ge) and the output media (such as
Film or RC pap e r, P ro o f : L a s e r, ink jet, f rom fi l m , e t c.). 

Note: You can specify a default Job Ticket that has typical
information in it, then make the appropriate changes to the
various Job Ticket tabs when a new job is created. To change
the Default Ticket, select “Preferences: Default Ticket” from
the Edit menu.



33

Collecting Job Elements

After yo u ’ve corrected the rep o rted pro bl e m s , ve ri fied that the job
documents are pro bl e m - f re e, and entered all the pertinent Jo b
Ti cket info rm at i o n , you are re a dy to gather all the documents, p i c-
t u re fi l e s , fo n t s , and miscellaneous support documents toge t h e r.

At collection time you can compress the files into a self-ex t ra c t i n g
a rch ive to save disk space, or for sending to the output fa c i l i t y. 

Collecting job elements:

1. Start a collection by clicking the “Collect Job” button on
the button bar in the Files tab window, or press zK.

2. At the Collection Setup dialog, deselect the options
“Collect Fonts” and “Compress into Self-Extracting
Archive.”

For this example, we will be collecting Pictures, but not col-

lecting Fonts. Preflight Pro automatically collects all Profiles
assigned to documents in the job: in this example, only the
“Sample Files Profile” will be collected, since that is the only
Profile that was assigned to documents in the job. We also
opted not to compress the archive.

Note: QuarkXPress must be running to collect the job. Part of
the collection process involves opening each document and
updating the link to the pictures in their new location. If
QuarkXPress is not open when Preflight Pro starts a collec-
tion, Preflight Pro will launch it.
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3. Click “OK” to examine a preview of what will be collected.

Before the files are actually gathered into the collection,
Preflight Pro will locate all the items to be collected and pre-
sent you with a list. This allows you to add files or remove
files from the collection list before the collection is gathered.

Note: For information on adding or removing files from the
collection list, refer to chapter 7, “Collecting Job Elements.”

4. Click the “Collect” button to gather the collection.

5. Choose a location to store the collection, and enter a name
for the collection folder.

6. Click “Save.”

Preflight Pro will gather together the job documents, all
assigned Profiles, and the job Pictures and/or Fonts, if these
were selected in the Collection Setup dialog. The collection
will be gathered and stored in the indicated location.

7. Quit Preflight Pro and examine the collection folder to see
the files that have been collected.

Open the collected job folder and notice that the job file is
there, along with a separate folder for each item that was col-
lected. In this example, there is a folder for the Job Files, Job
Profiles, and Job Pictures (there is no Job Fonts folder because
we did not elect to collect Fonts).

8. The Sample Job is now ready for output, or for delivery to
an output facility.
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